
Auctionpay Card Readers

Getting Ready for Event Day

Today I will provide a brief overview of the set up and use of the 
Auctionpay Card Readers during your fundraising event. 
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Event Day Training
Agenda

1. Pre-event preparations

2. Running reports for guest registration

3. Overview of registration procedures

4. Entering winning bids

5. Correcting mistakes

6. Checking out

7. Post-event procedures and wrap-up

This session will last about 15 minutes. The training today will cover a 
number of topics. I will provide suggestions for preparing for your event 
and setting up your equipment. I will also cover some recommended 
reports for expediting guest registration. I will walk you through the 
registration procedure using the Auctionpay Card Readers, and then we 
will discuss the data entry portion: entering winning bids and correcting 
mistakes. Then I will cover the check-out and cashiering and provide 
suggestions to make check-out more efficient. Finally, I’ll discuss some 
post-event reports and walk you through wrapping up your fundraising 
event.
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Questions After
the Training?

► Email: support@greatergiving.com
or call Client Services at: 1-866-269-8151

► Email questions are answered within one 
business day. 

► Client Services is available Monday-
Friday, 6:30 am – 5:00 pm PT.

If you have any questions during or after the training, please feel free to 
call Client Services at 1-866-269-8151 or send an email to 
support@greatergiving.com. Questions sent via email are answered 
within one business day. Phone support is available Monday through 
Friday from 6:30 AM to 5:00 PM Pacific Time.
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Event Software PC 
Download

1. Go to www. greatergiving.com and click Support Center

2. Click the Event Software icon

3. Click Download the current version 
of Greater Giving Event Software – 4.1

To download the latest version of Event Software PC, in your web
browser go to www.greatergiving.com. Click the Support Center button. 
Click the Event Software icon. Click Download the current version of 
Greater Giving Event Software 4.1.
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Software Download 
Login

To access the software, you will need to enter your login and password 
information, which can be found in the registration materials we
provided for you. I recommend saving the downloaded setup file to a 
removable device, such as a thumb drive, so you can install the software 
directly to each computer. 
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Pre-Event Preparations
Install the Event Software PC on each computer 
that will be in use at the event.

Network Server 
and Client

Network 
Client Only

Network 
Client Only

• This is a sample computer network for an auction event using the Auctionpay Card Readers.

• You will need 1 computer per card reader, and you may use a card reader with the server 
computer. You may have as many Network Clients as you need, even without a card reader.

*Greater Giving does not 
provide support for network 
setup or technical issues.  
Please consult an IT 
professional for assistance.

To use the Auctionpay Card Readers, you will need one computer per 
card reader at your event. To start, make sure Event Software PC is 
installed on each of the computers that will be in use. Your network 
needs one server computer, or a data center, hosting your event 
database. The other computers will be clients, which read the data from 
your server computer. Both server and client computers may be used 
with the card reader, and you may have as many additional computers 
as you like with no card reader attached. These machines can assist with 
data entry, but not registration or cashiering. 
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Pre-Event Preparations
Tips for setting up before your event

• Bring a printer to your 
event so you can print 
reports and receipts. (Bring 
more printers for more 
computers.)

• Test your network before 
your event using test 
bidders.

• Test each card reader
and call technical support if 
you run into any problems.

Here are some tips for making sure your event goes smoothly. Bring a 
printer to your event so you can print pre-event reports and guest 
receipts. I recommend having one printer for every one to two 
computers, to avoid a bottleneck during check-out. Also be sure to test 
your network ahead of time. You can do this by entering a test bidder on 
one computer and viewing the bidder on each of the other computers on 
the network. Finally, test each card reader device at least one day prior 
to your event in case you need to contact technical support. I will discuss 
testing in just a moment.
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Pre-Event Preparations
Download your Greater Giving Online database.

1. In the File menu, click Project 
Home.

2. Click the All tab.

3. Click Get projects from web.

4. Enter a Event Software Online 
username and password with 
organization admin rights.

5. Highlight the project and click 
Select Project.

6. You can overwrite an existing 
(open) database or download 
the online project as a new 
database.

For Event Software Online users, you can download your online database 
directly from Event Software PC for use at your event from the window 
shown here. To download your database, go to File and click Project 
Home. Go to the All tab and click Get Projects from Web. Enter your 
Greater Giving Online username and password. This login must have 
organization administrator rights in order to download the database. All 
available online projects will appear with a red and yellow arrow icon as 
shown here; select the database you wish to open and click Select 
Project. You may choose to overwrite an open database or open it as a 
new database. Please be aware that you can download a fresh copy of 
your online database (and overwrite any changes made offline) at any 
time by checking Download a fresh copy on the right. Once you have 
downloaded your final event database the morning of your event, please 
do not make additional online changes.
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Pre-Event Preparations
To move from an office computer to an event computer, 
make a back-up of your database to a memory stick or other 
removable storage device.

1. In the Utilities menu, click 
Backup Database.

2. Give the backup file a 
memorable name like “Dinner 
and Gala 2010 BK060910.”
Click Next.

3. Choose Hard Drive or 
Removable Media.

4. Click Browse and navigate to 
your removable media. Click 
Finish.

If you are working from a home or office computer and cannot download 
directly to the server machine you’ll be using at your event, you will 
need to back up your database for transporting via removable media 
such as a flash drive or memory stick. To back up, make sure all grid, 
form and letter views are closed and go to Utilities, then click Backup 
Database. Name your backup file and click Next. I recommend keeping 
the date appended to the file name to keep track of when you last 
backed up your database. Choose Hard Drive, Network Drive or 
Removable Media and click Browse to navigate to your memory stick 
or other removable media. Click Finish to save a backup of the database 
to the selected media.
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Pre-Event Preparations
At the event, you will need to restore the auction database 
to the server  computer.

1. In the Utilities menu, click 
Restore Database.

2. Choose Hard Drive or 
Removable Media.

3. Click Browse and navigate 
to your removable media. 
Click Next.

4. Choose your backup from 
the list and click Next.

5. Choose Overwrite the 
current database and click 
Finish.

Restore the database to the server computer at your event. To restore, 
plug in your removable media and open Event Software PC. Go to 
Utilities and select Restore Database. Choose Hard Drive, Network 
Drive or Removable Media and click Browse. Navigate to your 
removable media, click OK, and click Next. Choose the correct backup 
from the list and click Next. Choose Overwrite the Current Database
and click Finish.
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Pre-Event Preparations
Configure the software for the Auctionpay
Card Readers.

1. Plug the card reader into the USB 
port.

2. In the File menu, click Properties.

3. Click the Card Reader tab.

4. From your event preparation 
materials, find the EPS/EPCR code 
and enter it into the EPS Code field.

5. Press Test to test the card reader 
with an Auctionpay test card or any 
credit card. This card will not be 
saved.

6. Click Close, and click OK.

Run the test on each computer, with 
each card reader.

Next you’ll need to configure each computer for your Auctionpay Card 
Readers using your unique event code, called an EPS code or EPCR code.  
It’s helpful to configure the server computer before moving on to the 
client machines. I also recommend testing each computer and each card 
reader on the network before going live at registration to ensure 
everything is configured properly. You can perform the configuration 
process multiple times on multiple machines, so please feel free to test 
the card readers when they arrive on a home or office computer and 
please call Greater Giving technical support if you experience any 
difficulties. Plug the card reader into a USB port on the computer being 
configured. Go to File and Properties, then choose the Card Reader
tab, and enter the code in the EPS Code box. You can find your EPS 
code in your event confirmation email as well as the event materials 
shipped to you with the equipment. Click Test to open the Test Card 
Reader dialog. You can use one of the test cards shipped with the card
readers or a personal credit card for testing. No data will be saved here. 
Swipe the card and the card data will be populated in the appropriate 
fields. Click Close when finished and click OK or Apply to save your 
changes.
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Running Reports for
Guest Registration

The following are some of the most useful 
reports for handling registration:

• BID-01: Guest listing – Provides a detailed guest list.

• BID-02: Guest listing (2-column) – Provides a concise guest list.

• GRP-01C: Group listing – Lists guests by table group.
To access this report, in the View menu, click Grid Views then click Groups.

• UTL-05: Utility – Blank bidder registration forms
You can find all utility forms in the File menu, click Print General Report.

Here are some useful reports for making guest registration quick and 
painless: The Guest listing report provides a detailed guest list, 
including information like meal choice, table, group, mailing address, 
admission information, and more. The Guest listing (2-column) report 
is a more concise guest listing. The Group Listing report is accessible 
from the Bidder tab or the Group view, and lists your guests by table 
group. Finally, the Blank bidder registration forms report is useful for 
collecting information for guests who did not pre-register. You can find 
more blank forms under File and Print General Reports.
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Running Reports for 
Guest Registration

Use reports to streamline registration.

• To run a report, choose the appropriate tab 
in the Query Bar. (e.g., bidder reports from 
the Bidder tab or package reports from the 
Package tab.)

Use Reset to 
clear all fields 

before querying.

• Filter your report 
using the fields 
and click Query.

• In the File menu, 
click Print Report.

Now I will discuss some recommended reports for streamlining guest 
registration at your event. To run a report, such as the Guest Listing 
report, choose the appropriate tab. For example, to run the Guest 
listing report, choose the Bidder tab on the Query bar. Filter your 
report using the fields and click Query when finished. For the Guest 
Listing, I recommend using the Include only bidders who filter bar. 
Choose Have Seats Used and click Query to search for all bidders 
attending your event. If your results do not come up as you expect, try 
clicking Reset before applying your filters. Finally, go to File and Print 
Report, and choose the appropriate report from the list.
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Guest Registration
Auctionpay Card Readers allow you 
to quickly and securely capture credit 
card information.

• Press F8 on your keyboard to open the 
Sales Bar on any PC with a card reader.

• Click the Cards tab.

• Swiping a bidder’s credit card marks that 
bidder as ExpressPay.

Cards will not be
saved unless
entered through

the Cards tab.

STOP!

Your computer network is plugged in and ready to go, and each of your 
volunteers have a guest list in hand. To register bidders and use the 
Auctionpay card readers to securely capture credit card information, 
press F8 on the keyboard to access the Sales Bar and choose the 
Cards tab. Each computer swiping bidder cards will need to be on the 
Cards tab in order to save card information; any card data swiped to 
another location will be lost. All bidders with saved credit card 
information are marked as ExpressPay, indicating you have already 
collected payment for anything they purchase at your event.
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Guest Registration

1.
Offer to swipe your 
guest’s credit card for 
convenience at the event.

• If you swipe a card 
before choosing a bidder, 
the software will try to 
match the card to an 
existing bidder.

2.
Enter your guest’s bidder number or name 
and press Enter to auto-populate.

• To add a new bidder, click the + button.

• OR, simply enter the new bidder’s name 
and press Enter.

Begin the registration process by offering to swipe your guest’s card for 
convenience at the event. Many regular charitable event goers are 
already familiar with ExpressPay and will be glad to swipe a card ahead 
of time; others can wait until the end of the night to pay if they choose. 
You can enter a bidder’s name or number into the fields and press Enter
as shown in Step 2, or swipe the credit card and the software will 
attempt to match the cardholder name to a bidder in the database. If 
there is a match, the bidder’s information will be populated in the fields. 
If the software cannot find a match, you can add a new bidder record by 
clicking OK at the prompt. Optionally, enter the new bidder’s name in 
the bidder name field and press Enter on the keyboard, or you can click 
the green plus icon shown.
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Guest Registration

3.
After entering bidder information, swipe 
your guest’s card and click Save to save 
the credit card and the bidder will be 
marked as ExpressPay.

Your guests can always return at the end of the night for 
cashiering, so registering for ExpressPay is not mandatory.

To manually key in a 
card, just type the card 
number, expiration 
date and cardholder 
name as it appears on 
the card.

Swiping a credit card in the Cards tab will populate the Card fields as 
shown in step 3. When all bidder and card information is filled out, click 
Save to save the credit card and mark the bidder as ExpressPay. If you 
encounter an error swiping a card, you can manually enter the card 
number, expiration date, and cardholder name (as it appears on the 
card). Remember, if your guest chooses not to ExpressPay, he or she 
can return at the end of the night and swipe a credit card at that time 
instead.
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Entering Winning Bids
As your auctions close, enter the winning bid information in 
the F8 Sales Bar in the Sales tab.

Enter the package 
number or name 
and press Enter.
This auto-populates 
the package 
information here.

Enter the winning 
bidder (by name or 
number), the final sale 
price and click Sell.

Registration is over and your silent auction rooms have started to close. 
To enter the winning bid information, also known as the data entry 
phase, open the F8 Sales Bar and choose the Sales tab. Using the bid 
sheet, enter the package number or name and press Enter. This 
automatically fills in the rest of the package information. Then enter the 
winning bidder number and press Enter to populate the bidder 
information. Type the final sale price and click Sell. You can use Enter
or Tab to move from field to field anywhere in the Sales Bar.
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Entering Winning Bids
You can also sell multi-sale packages such as 
raffle tickets, walk-in admission, and more.

1. In the F8 Sales 
Bar, click the
Multi-Sales tab 
and select the 
multi-sale package 
you wish to sell.

2. Enter the bidder 
number or name 
and press Enter to 
populate.

3. Enter the quantity sold and press 
Enter to calculate the sale price.

4. Click Sell.

A multi-sale package can be sold multiple times. Multi-sale packages 
have a set sale price instead of a minimum bid. If you have sold any 
multi-sale packages at your event, such as raffle tickets, walk-in 
admission, or t-shirts, enter them in the Multi-Sale tab of the F8 Sales 
Bar. From the MS Package drop-down list, select the package to sell. 
Enter the bidder information and press Enter, then enter the quantity, 
press Enter again, and click Sell. Using Enter will automatically 
calculate the total sale price. You can always override the sale price 
manually. This is helpful if you sell your multi-sale packages in bulk at a 
discounted price, for example: 3 raffle tickets for $15.
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Making a Multi-Sale 
Package

If you haven’t already created your Multi-Sale packages, in the Data
menu, click New Package. Fill in the package number, the package 
name, make sure to click the Multi-Sale box. Finally go to the Bid 
Sheet Values area and check the box to override bid sheet values and 
update the Price field to the price that you would like to charge per sale. 
Once set up, press F10 to save or F11 to save and create another multi-
sale package.
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Checking Out

1. To print receipts for all bidders that made 
purchases at your event, in the Query Bar, 
click the Bidder tab.

2. Enter 1 into the first box next to $ Spent.

3. Click Query.

4. In the File menu, click Print Report. 
(Optionally use CTRL + P or click the 
printer icon.)We only want to print 

receipts for bidders 
with purchases.

Speed up your check-out process by printing 
batch receipts.

You can filter any report this way.

We have entered all our sales and now we will start discussing check 
out. You have two options for printing bidder receipts. You can print all 
of them at one time using batch mode printing, or you can print receipts 
for each bidder when they check out. First we will discuss how to print all 
receipts in a batch. Printing bidder receipts before check-out begins is a 
great way to streamline cashiering at the end of the night. To print 
receipts for all bidders that made purchases at your event and avoid 
printing receipts with no sales, choose the Bidder tab of the Query bar 
on the left-hand side. If the Query bar is hidden, press F7 to display it. 
Enter the number 1 in the first box next to Dollars Spent and click the 
Query button. With the bidder grid displayed, go to File and Print 
Report. Remember that you can filter any report this way.
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Checking Out
Speed up your check-out process by printing 
batch receipts.

• From the Select Report Output 
Type dialog, choose the BID-06: 
Receipts with settings dialog.

• Once you’ve set up your receipt 
once, you can choose BID-06a: 
Receipts with presets to skip the 
questions.

Any bidders that are not marked Express 
Checkout will need to swipe a card or 
provide an alternative form of payment.

In the report dialog, choose the Receipts with settings dialog report 
the first time you run your receipt to set up your receipt preferences. 
Next time you choose to print a receipt, the Receipts with presets
report will remember your settings. Click Print to print a copy of the 
receipt for each bidder in the grid. Any bidders that are not marked 
Express Checkout on the receipt will need to provide some form of 
payment at cashiering. Anyone marked for Express Checkout can bypass 
cashiering and go directly to pick up their items since you have already 
collected a form of payment from them.
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Printing All Receipts 
at One Time

If you need more than one copy of each bidder receipt when you print 
them in batch mode, you just need to indicate that on the Print dialog 
box that opens when you click Print. This dialog box opens and under
Number of copies enter the number of copies that you would like to 
print.
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Checking Out
Printing individual bidder receipts

1. In the F8 Sales Bar, click the Bidder Info tab.

2. Click Print 
Receipt to print 
the receipt, or 
click View 
Receipt to view 
the Bidder 
Purchases 
Form before 
printing.

To change the number of receipt copies 
printed by the software, in the File menu, 
click Properties and then click Reports. 
(The default is 2.)

You can also print receipts for individual bidders using the Bidder Info
tab of the F8 Sales Bar. Enter the bidder number or name and press 
Enter. Next to Action, select Print Receipt and click the action button 
(which now reads Print Receipt) to send a paper copy of the receipt 
directly to the printer. Select View Receipt from the action menu to 
view a list of purchases, payments and credit cards on file. To change 
the number of copies of the receipt that print from the Bidder Info tab, 
go to File, Properties, and choose the Reports tab. It defaults to 2 
copies: one for you and one for your guest. You will want to ask the 
guest to sign the merchant copy of the receipt to authorize the payment.
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Checking Out

Entering other forms of payment

For guests who choose to pay by cash or check, in the 
F8 Sales Bar, click the Payments tab.

DO NOT enter payments for credit card charges submitted through the 
software. These are automatically generated during the banking process.

It’s time to collect payments. For guests who choose to pay by cash or 
check, choose the Payments tab of the F8 Sales Bar. Enter all cash, 
check, and other non-credit card payments in this tab. Simply fill out the 
bidder number, payment type, dollar amount, and click Pay. Remember: 
Do not enter payments for credit cards here, even during cashiering. 
Payments for credit cards are automatically generated during the
banking process. If you manually enter credit card payments, the
associated cards will not be charged correctly.
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Checking Out
Cashiering is simple.

To cashier bidders, click the Cards tab and 
swipe a credit card, clicking Save as usual. 
They will be marked as Express Checkout
and billed along with your pre-swiped 
bidders.

Click here to 
view cards 
on file for 
any bidder.

REMEMBER: Cards 
swiped outside the 
Cards tab will NOT 
be saved.

Cashiering bidders that are paying by credit card is simple, and identical 
to the registration process. On the F8 Sales Bar, open the Cards tab. 
Enter the bidder information, swipe the credit card, and click Save. 
Bidders that swipe after the event are marked ExpressPay along with 
bidders that swiped before the event, and they will all be submitted to 
the bank together. Remember that cards swiped anywhere besides the 
Cards tab will not be saved, and thus cannot be billed for the amount
due. If a bidder would like to swipe a new credit card, you can view 
cards already on file by clicking the Cards button. I’ll come back to split 
pays in a moment.

25



Correcting Mistakes
Replace, modify, or delete sales from the F8 
Sales Bar.

1. To replace a sale, click the Sales
tab and enter the sold package 
number or name. Press Enter.

2. Enter a new bidder number and 
sale price and click Sell. 

• To modify a sale, enter a new sale 
price and click Sell.

• To delete a sale, simply delete the 
bidder number and click Sell.

After printing a bidder receipt, your guest may find errors or have 
questions about purchases listed on the receipt. To replace a sale of a 
package, or sell the package to a different bidder, choose the Sales tab 
of the F8 Sales Bar. Enter the package number and press Enter. The 
Sales Bar will fill in the winning bidder that was previously entered. To
replace the sale, change the bidder number, press Enter, correct the 
sale amount if necessary and click Sell. The software will prompt you to 
replace the existing sale or add a new one. You may sell packages to 
more than one bidder. You can split a package between bidders this way 
or sell the same item multiple times if you have more than one. If you 
would like to modify the sale price of an existing sale, bring up the sale 
the same way, change the sale price and click Sell, then click Replace
to remove the old price and enter the new one. To delete a sale, enter 
the package number and press Enter to view the current purchaser. 
Delete the bidder number from the box and click Sell. The software will 
prompt you to delete the sale. Click Continue to remove the sale.
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Correcting Mistakes
You can also view and delete sales from the 
Bidder Purchases Form.

• In the F8 Sales Bar, click 
the Bidder Info tab and 
click View Receipt to view 
the Bidder Purchases 
Form.

• To delete a sale, select the 
sale under Purchases and 
press the Delete key.

• View credit cards a bidder 
has on file here.

Additionally, you can view and delete sales from the Bidder Purchases 
Form. From the F8 Sales Bar, choose the Bidder Info tab. Next to 
Action, choose View Receipt, and click the action button to bring up 
the Bidder Purchases Form. Here you can add or delete sales listed in 
the Purchases grid or payments listed in the Payments grid using the 
Insert and Delete keys on your keyboard. Credit card payments 
pending submission are listed in the Credit Card Charges to be 
Submitted grid. To view or edit credit cards on file, click the View Edit 
Cards button.
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Correcting Mistakes
Manage cards on file and perform split pays with 
View/Edit Cards.

• Move cards up and down on 
the list to determine in what 
order they will be billed.

• For Split Pays, enter the first 
card’s billable amount as the 
Max. Amt. and move it to top 
position on the list.

• You can swipe and save any 
additional cards by clicking 
Add in the Bidder Credit 
Cards Form.

You can manage credit cards on file and perform split pays using the 
View Edit Cards button in the Bidder Purchases Form. Use the Move 
Up or Move Down buttons to determine in what order the credit cards 
on file will be billed. If there are no Maximum Amounts entered, the 
total amount will be billed to the first card on file. To perform a split pay, 
add a Max Amount by double-clicking on the card in the Bidder Cards 
Form. Put all cards with Maximum Amounts first on the list. The 
remainder will be billed to the cards that appear lower on the list. Click
Add to swipe and save any additional credit cards.
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How to Split Pay

Here is an example of a completed record for split pay. Notice the Max 
Amount is filled out for the top card on file. The remaining balance will 
be charged to the card below.  This process can be done multiple times if 
the client wishes to split the amounts among more than two cards.
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Event Wrap-up
Back up your database and run final event 
reports.

• At the end of your event, in the Utilities menu, click Backup Database to 
secure all of your event data and remove it from the event site.

• Here are some common post-event reports:

BID-03: Sales listing by supporter – Details purchases by bid number.

PKG- 03: Sales listing by package with buyers – Lists package sales by 
package number.

PAY-02: Payment totals by type – Event revenue.

SUM-13: Summary – sales totals by pkg. sorted by amount and SUM-
14: Summary – sales totals by bidder sorted by amt. rank highest-
grossing bidders and packages.

You can find all SUM reports in the File menu, click Print General Reports.

Your event is over and your guests have gone home. Now it’s time to 
back up your database, run some final event reports to congratulate 
yourself on a job well done, and head home as well. To back up your 
database to your removable media, such as a memory stick, close all 
open grid views and go to Utilities, then select Backup Database. 
Some common event reports are the Sales listing by supporter, which 
details all purchases by bidder number; the Sales listing by package 
with buyers, which lists package sales by package number; the 
Payment totals by type, which displays your event revenue by 
payment type; and the Summary sales totals by package sorted by 
amount and the Summary sales totals by bidder sorted by amount
reports rank your highest-grossing bidders and packages. Summary 
reports are accessible by going to File and Print General Report. The 
summary reports are also helpful during your event to stir up excitement 
by capitalizing on high-bidding guests and luxurious packages.
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Submitting to the bank
• Run the BID-18: Charges to be 

submitted report for all ExpressPay
bidders with an outstanding balance, 
listing the amounts to be submitted.

• When you’re ready to submit, in the 
Data menu, click Submit Credit Card 
Charges. You can review the list once 
more before submitting.

• Click Submit Charges and enter your 
Event Software PC username and 
password. 

• This process automatically generates a 
payment for each of your submitted 
charges.

Event Wrap-up

After getting a good night’s sleep and double-checking your data entry, 
it’s time to send your credit card charges to the bank. Run the Charges 
to be submitted report for a list of all bidders with a credit card on file, 
detailing the card type and the amount to be transmitted. When you are 
ready to submit, go to Data and Submit Credit Card Charges. You can 
view the charges again under the Charges to be Submitted grid, and 
click Submit Charges when everything looks good. You will need your 
Event Software PC username and password to authorize this process. 
Submitting your charges automatically generates a payment upon 
approval for each of the transmitted amounts. You can view these
payments on the Query bar, under the Payments tab. Look here for 
approval codes or other detailed transaction information.
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Event Wrap-up
Synchronizing your database with Greater 
Giving Online
• Once all outstanding balances 

are resolved, in the Data menu, 
click Synchronize with Online 
Project to send your event 
information up to Event Software 
Online.

• After the sync, a summary of 
uploaded data appears.

The synchronization will fail if you 
have any credit card charges 
awaiting submission.

For those users that originally downloaded the event night database 
from Event Software Online, you can upload your new data back online 
using the synchronization tool. Once all outstanding credit card charges 
are submitted, go to Data and select Synchronize with Online 
Project. After the synchronization is complete, a summary of uploaded 
data will appear. Keep in mind that the synchronization will fail if you 
have any credit card charges to be submitted.
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Greater Giving Support

► Call Client Services at: 1-866-269-8151

Monday-Friday: 6:30 am – 5:00 pm PT

After-hours support is available for 
event night only at the same number.

► Email: support@greatergiving.com
Questions are answered within 1 business 

day.

► Visit our website at www.greatergiving.com

If you have any questions, feel free to give us a call at 1-866-269-8151 
or email us at support@greatergiving.com. Emailed questions are 
answered within one business day. Our phone support line is available 
for general inquiries Monday through Friday, 6:30 AM to 5:00 PM Pacific 
Time. After-hours support is available for organizations on event night 
only. For resources regarding the card readers or Event Software PC, 
visit www.greatergiving.com and click on the Support Center. Thank 
you. 
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End of Presentation


